
JIRA Tracking # Title Summary

DM-6577

DM Application Integration - Windows Picture or Fax 

Viewer - Error Message Appears When the Download 

Path Contains a Space 

In eDOCS DM, using DM Application Integration with Microsoft 

Windows Picture or Fax Viewer, if you attempt to open an image 

document, and the download path specified in the Client 

Deployment Utility (CDU) contains a space, an error message 

DM-12498

DM Application Integration - PowerPoint 2007 - 

Opening Documents from DM May Result in Missing 

Edits 

In eDOCS DM, using Application Integration for Microsoft 

PowerPoint 2007, if you open a profiled document from within DM 

Extensions, make edits, and then save the document, the next time 

you open the document, your edits may be missing.

DM-12764

DM - French - A Blank LocationSaveForm Dialog Box 

May Appear When Attempting to Create a Paper Profile 

In eDOCS DM (French), if you attempt to create a Paper profile, the 

LocationSaveForm dialog box appears instead of the Paper 

Document dialog box, and the LocationSaveForm dialog box is 

blank.

DM-12994

DM 5.2.1 : Save UI Location field behaves different 

depending on where it is called from.

The Problem: 

When bringing up the Save UI by dragging and dropping a 

document into a dynamic view node in Explorer Extensions the 

Location field in the Save UI shows the whole path to that node (for 

DM-13326

DM 5.2.1 Switch to/Retry error in Word Perfect In DM 5.2.1 using Word Perfect 13 it is possible to get a Switch 

To/Retry screen when attempting to save documents or navigating 

the profile screen. It seems to occur more in slower environments, 

for example in my VMWare test environment I am able to 

DM-14083

Changing tab order on profile form generates sql error 

as order of datatypes in sql insert statement become 

scrambled

Going Designer to change tab order of profile form document to fail 

to save. Error generated at sql level. 

On the BYRDTEST1 profile form, I altered the tab order of the 

Company_ID and the Person_ID fields (they are both "Xxxxx" fields 

DM-14284

DM 5.2.1 French Version Cannot set location to any 

value containing accents when removing items from a 

box

When a user attempts to remove a File Part from a box they receive 

the following error 

Pa' Ce'Faut " is not a Valid Locator 

DM 5.2.1 cannot set location to any value containing accents when 

DM-14647

Outlook Crashes when Message with Multiple Email 

attachments is dragged to Library node and profiled

1. Open an email with multiple attachments. Attachment type does 

not appear to have any effect. Drag the email and drop it on the 

Hummingbird DM \ LibraryName folder in the Outlook tree 

2. The "Save to Hummingbird DM" dialog panel appears. 

DM-14676

DM Extensions – Save User Interface May Be Slow to 

Appear 

In eDOCS DM, using DM Extensions, when you save a Microsoft 

Word document to DM, the Save user interface may be slow to 

appear.

DM-14831

DM521HF1: time shown in DV level with a deviation of 

one hour

When we file emails into the system, time is correctly shown in 

profile and recent edited, but if you go to DV level the time is 

displayed with a deviation of one hour more, ie. and email filed at 

13:00 appears like at 14:00. This happens only at this level, we 

DM-14961

RM Extensions - Results List May Be Empty When 

Searching on the "Read Only Date" Field 

In eDOCS RM, if you execute a Profile search using the Read Only 

Date field as the criteria, no results are returned. 

This issue was reported in (but may not be limited to):

DM-15164

Versions dialog box 'freezing' when selecting a 

document from the QR window The client has discovered that installing DM on their new core 2 

quad machines causing an issue where the versions dialog will 

freeze when used from the QR window. 

DM-14741

DM5.2.1 HF1 - Webtop - when importing an office 2003 

document the file extension is converted to office 2007 

format

Imported Office 2003 document extensions are converted to Office 

2007 document extensions 

This is basically the same problem reported in DM-11575 , except 
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DM-12577

DM Web Admin - Group and User Synchronization - 

New Members of a Group May Be Ignored When 

Synchronizing to an Oracle Database 

In eDOCS DM, using Group Synchronization in DM Web Admin with 

an Oracle database, if you add new members to a group, and then 

reimport the group to DM, the new members may be added to DM.

DM-5993

DM Application Integration - Empty Version Selection 

Dialog Box Appears When Opening a Document 

In eDOCS DM, using DM Application Integration, if you attempt to 

open a document from a Quick Retrieve dialog box, to which you 

have only View Profile rights, the Version Selection dialog box is 

empty, and the OK button appears dimmed (is unavailable). If you 

DM-11861

DM Extensions - Adobe Reader - PDF Documents May 

Remain Locked After Closing 

In eDOCS DM, using Adobe Reader configured with "No 

Integration" in Library Maintenance, if you attempt to reopen a 

PDF document that you just closed during the current session, an 

error message appears indicating that the document is locked.

DM-13313

DM 5.2.1 CU1- Excel 2007 - Native saves default to 

wrong file type

When saving a document natively from Excel 2007 application the 

native dialog will always default to the XML file format for that 

application XLSX even when the default file format is set to 

something else. 

DM-13314

DM 5.2.1 CU1- Word 2007 - Native saves default to 

wrong file type

When saving a document natively from Word 2007 application the 

native dialog will always default to the XML file format for that 

application DOCX even when the default file format is set to 

something else. 

DM-13315

DM 5.2.1 CU1- PowerPoint 2007 - Native saves default 

to wrong file type

When saving a document natively from PowerPoint 2007 

application the native dialog will always default to the XML file 

format for that application PPTX even when the default file format 

is set to something else. 

DM-13368

eDOCS DM - Microsoft Word - Documents Remain in 

Checked Out State after Running a Compare and Merge

In eDOCS DM, using Microsoft Office 2007 integrated via COM 

Automation, when you compare two documents, the original 

document and the revised document are left in a checked out state 

until DM.exe is removed from memory. 

DM-13590

Missing edits when the file name of a document is 108 

characters or more.

Problem: 

When a user saves a document with 108 characters or more the 

document saves into DM without issue. The document name is 

correct in the database and can be viewed normally. 

DM-13893

DM Application Integration - Word - Changes May 

Appear in the Original Document Instead of the New 

Document When Using Compare and Merge 

In eDOCS DM, using Application Integration for Microsoft Word 

with COM Automation, when you use the Compare and Merge 

feature with two profiled documents, and you select the option to 

have the changes appear in the new document, the changes may 

DM-14609

DM search server 521 CU1 corrupt when some of the 

partitions reaches over 2 gig in size

Take a look at the *.ref files. in normal operations DM switch to 

create the new set of index when any .ref file reaches ~1G in size. If 

it is the case, the following files from the list below reaches 2 gig in 

size and that is causing corruption to the point where clients have 

DM-14615

DM 5.2.1cu1 - Change the way searches return 

documents when documents have been secured against 

groups/users that are disabled.

Customer has raised a high priority request to change the way 

searches return documents when these documents have been 

secured against a user and/or group that has been disabled. 

DM-15011

DM Extension for Microsoft Outlook - Items May 

Appear Incorrectly in the DM Tree View 

In eDOCS DM, using DM Extension for Microsoft Outlook, DM 

libraries and other items may appear incorrectly in the tree view. 

For example, if you have three or more remote libraries, when you 

expand the DM node and click a Library name, the sort order of the 

DM-15098

DM Server - DCOM Error Messages Appear in the Event 

Viewer After Installing DM 5.2.1

In eDOCS DM, when you install DM 5.2.1 on a Microsoft Windows 

2003 sever with Service Pack 2 applied, multiple DCOM error 

messages appear in the Event Viewer.
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DM-9103

DM Extension for Microsoft Outlook - Document 

Remains Locked After Creating a New Version 

In eDOCS DM, using DM Extension for Microsoft Outlook, if you add 

a new version to an existing document, the document remains in a 

locked state.

DM-11673

DM Extensions - Multiple Document Profile Dialog 

Boxes May Appear When Using the "Apply to all" 

Option During a Document Import 

In eDOCS DM, using DM Extensions, if you attempt to import a 

group of documents from different applications, and you select the 

"Apply to all" check box on the first Document Profile dialog box, a 

new Document Profile dialog box may appear for each document 

DM-11976

DM - Content Cache Server - "Unable to Copy content to 

the cache" Error Message May Appear When Uploading 

Documents with a High Latency Connection 

In eDOCS DM, if you use a Content Cache server with the Lazy 

Write feature enabled, and you have a high latency connection to 

the document server (for example, a VPN connection), an error 

message may appear in the Windows Event Viewer after uploading 

DM-12815

DM521 - Deleting unread meeting request in Outlook 

XP inbox throws error - The add-in "C:\Program 

Files\Hummingbird\DM Extensions\Email 

Integration..." could not be installed or loaded

With the DM client installed, if you delete an unread Meeting 

Request from Outlook, the warning message shown in the 

attachment is presented 

DM-12928

DM 5.2.1 - RED List not showing true recent edits. Problem: 

The RED list in Explorer DM Extensions or Outlook Extensions is 

not showing a true list of documents that have been recently 

edited. Instead it includes in this list documents that have been 

DM-13317

DM 5.2.1 CU1 File format not changing when saving 

documents in Word 2007

When saving a document in Word 2007, if the default save options 

are set to save documents in 2003-97 format and you open a 

document from the file system that is in 2007 format, the saved file 

into DM will not be in 2003 format. It will remain in 2007 format. 

DM-13321

DM Application Integration - Word 2007 - Document 

Format May Be Incorrect When Saving a Read-Only 

Document Originally Created In Word 2003 

In eDOCS DM, using DM Application Integration with Microsoft 

Word 2007, when the Word Application ID in DM and the Save 

Options in Word are both set to use the .DOCX extension, if you 

attempt to save a Word 2003 document, the document format may 

DM-13867

DM Extensions Dynamic Views - Ad Hoc Folders May 

Disappear After Modifying Level Search Items 

In eDOCS DM, using DM Extensions Dynamic Views, if you add an ad 

hoc folder to a view level and then add (or remove) a search object 

to that level, the ad hoc folder may disappear.

DM-14121

DM 5.2.1 Dump File Analysis Please analyze the attached DMP files and determine the cause of 

the docsfusion.exe process hanging. 

DM-14249

DV Refresh Contents changes the tree structure to 

include all Matters not subscribed to.

Steps to reproduce. 

(NB: Have no subscriptions) 

1. Start Outlook 

2. Expand the All Matter Node 

DM-14276

DM 5.2.x/Outlook 2007: Looking at Folder Properties 

Causes Outlook to Crash

In Outlook 2007, when a user right-clicks on any folder in the pane 

view and chooses properites, then either clicks OK or Cancel, the 

DM toolbar icon disappears. Then when they close Outlook, the 

application crashes. 

DM-14409

Exporting an e-mail to DM defaults to incorrect library Using Outlook 2007, DM 5.2.1, exporting an e-mail to DM will 

default to the incorrect library. The customer's default library is 

PJMDOCS, but exporting e-mail messages will default to library 

PJMBOARD, even for users who don't have access to that library. 

DM-14430

DM Extensions - Attaché - Offline Cache Folder May Be 

Deleted Automatically 

In eDOCS DM, using DM Extensions, if you make multiple attempts 

to log on to DM through Attaché, your DM cache folder may 

disappear, and an error message appears.
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DM-14481

Outlook Crashes on Exit when Multiple Outlook 

Windows are open and multiple Outlook Toolbars 

butons are present

If a user uses multiple Outlook windows, Outlook will become 

unstable on close when multiple Outlook toolbar DM buttons exist. 

Start Outlook 

DM-14584

Exporting / dragging and dropping emails into DM 

profiles with an AM time stamp for the Received and 

Sent fields

If Exporting or dragging and dropping emails into DM Ext-Outlook 

with a received time of 12 noon through 12:59 the email's profile 

will display a received and sent time of AM instead of PM. 

DM-14670

DM 5.2.1 CU1 -Exporting / dragging and dropping 

emails into DM profiles with an AM time stamp for the 

Received and Sent fields

If Exporting or dragging and dropping emails into DM Ext-Outlook 

with a received time of 12 noon through 12:59 the email's profile 

will display a received and sent time of AM instead of PM. 

DM-15051

DM 5.2.1 Document object gets closed before COM 

integration code completes.

Problem: 

When a user closes a document and the document is dirty the 

DMSave or DMSaveAs event fires in COM. 

The Save completes but in some cases where there are AfteraSave 

DM-12369

Customer would like to set the option "Replace 

attachments with DRF's" as their default option.

Customer would like to set the option "Replace attachments with 

DRF's" as their default option, so that their users do not have to 

change any settings when profiling emails. 

DM-14017

DM 5.2.1 Modify indexer defaults causes the SS 

FSSIndexDefaults registry key to corrupt

Problem: 

If the indexer defaults are modified in the DM Server Manager then 

the 

HKEY_LOCAL_MACHINE\SOFTWARE\Hummingbird\DOCSFusion\I

DM-2491

DM Webtop - DM Indexer - An Exact Phrase Search May 

Return Both Singular and Plural Words 

In eDOCS DM, using DM Webtop, when you perform a content 

search using the Exact Phrase field, if you enter a plural word as 

the search criteria, singular versions of the word may also be 

returned in the search results.

DM-9544

You are not authorized to perform the requested 

operation Error Message Appears When Performing a 

Mass Profile Update 

In eDOCS DM, if you perform a mass profile update on secured 

documents, and you do not have Control Access rights to one or 

more selected documents, an error message appears in the Update 

Complete dialog box, and the update for those documents fails.

DM-11739

DM 5.2 - Lotus 7.0 - Mail integration - Nodes do not 

refresh(ctrl + right click and select refresh tree list) 

after adding a workspace or a document to Attache.

Problem Description: 

1. Integrate Lotus Extensions 

2. Open the Lotus Mailfile and open the DM node. 

3. If I select the Workspaces node from eDOCS DM Lotus 

DM-11952

Outlook 2007 - Email Integration crashes when opening 

a Calendar item (New or Existing).

Steps to reproduce 

1. Open Outlook 2007 

2. Click Tools - Options 

3. Select Other Tab 

DM-12037

DM Extension for Lotus Notes - Quick Search Context 

Menu Items Are Unavailable 

In eDOCS DM, using DM Extension for Lotus Notes, when you press 

the CTRL key and right-click a saved Quick Search, the DM context 

menu items are unavailable.

DM-12614

Bug-Only Excel Format and "All Files" are available in 

the native dialog box

When using eDocs DM 5.1.05 SR6MR3 with ODMA integration 

(active or passive) for Excel XP, the native save dialog lacks file 

format options other than "Excel Workbook" and "All Files". 

If you remove the macro from XLStart and start Excel, the file 

DM-12905

DM - Performance problems with MS Office2007 and 

DM 5.2.1 COM

Customer has found performance problems opening and saving 

new or existing documents in DM using MS Word2007. 

In order to open an existing document 22Kb from MS Word 2007 

and DM 5.2 COM, they spent 10 seconds. For saving new versions or 
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DM-12931

DM Extensions - Save User Interface - Cursor Should 

Appear in the Document Name Field When Saving a 

New Document 

In eDOCS DM, using the Save user interface introduced in DM 5.2, 

when the Document Profile dialog box appears during creation of a 

new document, the cursor may not be positioned in the Document 

Name field . 

DM-13027

DM Application Integration - GroupWise - Recipient 

Information May Be Missing When the Cc Email 

Address Is External 

In eDOCS DM, using DM Application Integration for Novell 

GroupWise, if you attempt to profile an email message that 

contains an external email address in the Cc or To fields, the 

information does not appear in the corresponding field on the 

DM-13233

Outlook Ribbon buttons dissappear randomly In Outlook, the DM5 icons occasionally disappear from the ribbon. 

The work around is to restart Outlook if you need these icons, or to 

use the small disk icon on the main Outlook screen. 

DM-13265

DM 5.2.1 - Outlook Extensions - Outlook 2003/ 2007 

does not allow user to log in to DM If You Choose "Move 

to Folder" on an Email before Logging Into DM.

In DM 5.2.1 

In Outlook 2003/ 2007 

Steps to reproduce: 

DM-13515

DM Application Integration - Word - Focus May Change 

When Saving a New Document Using ODMA Integration 

In eDOCS DM, using Application Integration for Microsoft Word 

with ODMA, if you have two documents open, and you click Save As 

from the File menu on one document, when the save is complete, 

the focus changes from the newly saved document to the other 

DM-13724

Ability to Integration DM 5.2.x with Lotus Notes 8 Basic Customers request the ability to integrate DM with Lotus Notes 8 

Basic.

DM-13767

DM5.2.1 produces an error message if user clicks 

"ENTER" directly after entering part of validation field

DM5.2.1 produces an error message if user clicks "ENTER" directly 

after entering part of validation field. 

However, after producing the error message, DM5.2.1 correctly 

expands thevalidation field.and clicking save again is successful. 

DM-14007

DM 5.2.1 - File and Send button on Outlook Ribbon is 

displayed even when it is configured not to.

Problem: 

When users are choosing to mail a document from the DM system - 

a new email window is opened with the document attached. On the 

office ribbon the 'File and Send' button is displayed even though it 

DM-14099

DM Application Integration - Word - Focus Issue During 

a Native Save May Cause the Document Name to Be 

Overwritten 

In eDOCS DM, using Application Integration for Microsoft Word 

with Active COM Automation, if you save a new document natively, 

and then attempt to save another document natively, while the first 

document is still open, the name of the first document may be 

DM-14099

521 CU1 locked documents when certain code is called. Documents remained locked with templates contain code in 

EventReplaceDMSaveAs 

Close DM5.2.1. 

DM-14137

DM Extension for Microsoft Outlook - French - Outlook 

May Terminate Unexpectedly When Selecting an Item 

in the DM Node 

In eDOCS DM, using the French release of DM Extension for 

Microsoft Outlook, if you expand the DM node in the tree view, and 

select an item in the tree, Outlook may terminate unexpectedly.

DM-14264

Lotus Notes displays 'External Function not found' 

when trying to open a document from a profile search 

result page

Lotus Notes displays 'External Function not found' when trying to 

open a document from a profile search result page 

Steps to reproduce: 

DM-14451

DM5105 - If you drag and drop mulitple emails into DM 

and one does not have a subject some of the emails are 

not saved in DM and are deleted from Outlook too

DM5105 - If you drag and drop mulitple emails from the customer's 

.pst file into DM and one does not have a subject some of the emails 

are not saved in DM and are deleted from Outlook too. 

Steps to Reproduce: 

5 of 6



DM-14618

Apply to all doesn't work when profiling multiple 

documents using a form that is not selected as primary 

profile

Steps to Reproduce the issue. 

1.Open Library Maintance -> Groups -> DOCS_SUPERVISORS -> 

Forms - > Profile Entry 

2. Profile Entry: 

DM-14967

DM Application Integration - Visio - Second Document 

May Be Checked In Automatically When Opening Two 

Consecutive Visio Documents 

In eDOCS DM, using Application Integration for Microsoft Visio, 

when you open two consecutive Visio documents, the second 

document may be checked in automatically, even though both 

documents remain open in Visio.

DM-14967

521 CU1 -DM Application Integration - Word - Items 

That Appear on the Word "Recently used file list" Point 

to the Wrong Location

In eDOCS DM, using DM Application Integration with Microsoft 

Word integrated via COM Automation, and the "Recently used file 

list" option enabled in Word (Tools>Options>General), if you open 

a document, the item is added to the bottom of the File menu. 

DM-15069

DM Designer - Changes to the Tab Order on a Form 

Only Appear After the Form Is Closed and Reopened

In eDOCS DM, using DM Designer, when you modify the tab order 

on a form and save it, the changes may not appear until after you 

close and reopen the form.

DM-8422

Hummingbird Enterprise Webtop - DM - "You have an 

existing DM Extension session

In Hummingbird Enterprise Webtop 5.2, using DM 5.1 or 5.1.0.5, if 

you attempt to access a Quicksearch, or use a DM eClip, an error 

message might appear if the DM Auto Logon feature is enabled in 

Library Maintenance. 

DM-1506

DM Administration - Library Maintenance - Profile 

Defaults Should Be Copied When Copying a Group 

In eDOCS DM, using DM Library Maintenance, when you copy a 

group that has profile defaults set, the profile defaults are not 

copied to the new group.

DM-6265

DM Extension for Microsoft Outlook - Nothing Happens 

When You Attempt to Drag an Email Message to a DM 

Folder

In eDOCS DM, using DM Extension for Microsoft Outlook, if you 

attempt to drag an email message to a DM folder, the system might 

not recognize that an item has been selected; as a result, nothing 

happens. If the process is repeated several times, eventually, the 

DM-12639

DM Application Integration - Word 2003 - Performance 

Issue When Opening a Large Document Using Passive 

Integration 

In eDOCS DM, using Microsoft Word with Passive Integration, if you 

attempt to open a large document that contains images or tables, it 

may be slow to open.
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